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Trademark Information

ASD Inc.

2555 55th Street 
Boulder, CO 80301 USA 
Phone: (303) 444-6522 
www.asdi.com

FieldSpec®, LabSpec®, QualitySpec®, TerraSpec®, AgriSpec®, RxSpec®, 
ViewSpec™, RS3™, Indico™, and goLab™ are registered, and unregistered 
trademarks, and the intellectual property of ASD Inc. All trademarks used or 
displayed in this document are the property of ASD, its affiliates, or third 
party owners. Unauthorized use of these trademarks is illegal and punishable 
by law. Nothing contained in this document is to be construed as granting, by 
implication, estoppel, or otherwise, any license or right of use of any such 
trademark without the prior and express written permission of ASD, or such 
third party owner.

This document contains proprietary information protected by copyright law 
and may not be reproduced in any manner without the express written 
approval of ASD Inc.

The information and specifications contained in this manual are subject to 
change without notice. ASD Inc. shall not be held liable for technical, 
editorial omissions, or errors made herein; nor for incidental or consequential 
damages resulting from furnishing, performance, or use of this material.

 

Technical Support

If you have any questions or concerns, please contact ASD Inc. by phone, fax, 
or email:

Phone: 303-444-6522 X-144 
Fax: 303-444-6825 
email: support@asdi.com 
Web: www.asdi.com 
ftp: ftp.asdi.com

Technical support is committed to providing you with a timely response to 
your questions. We will work with you to provide solutions to your 
applications. Technical support is available to answer your questions Monday 
thru Friday, 8 am to 5 pm Mountain Standard Time. We will happily respond 
to your e-mail queries as well.
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Declaration of Conformity

 y
According to IEC guide 22 and EN45014 

Manufacturers Name: Analytical Spectral Devices, Incorporated.  
Manufacturers Address: 5335 Sterling Drive, Suite A 
 Boulder, CO   80301 
 Phone: (303) 444 6522 
European Contact: Your local Analytical Spectral Devices Representative. 

Declares that the product(s) 

Product Name:  QualitySpec  Pro 
Product Numbers  Description Range (nm) 
A100700 VNIR 350-1050  
A100710 VNIR & SWIR1 350-1800  
A100720 SWIR1 1000-1800  
A100730 SWIR2 1800-2500  
A100740 SWIR1 & SWIR2 1000-2500 
A100750 Full Range (VNIR, SWIR1, & SWIR2) 350-2500 
A100760 Full Range High Resolution  350-2500 

Conforms to the following EU Directives: 

Safety:  Low Voltage Directive, 72/23/EEC, as amended by 93/68/EEC 

EMC: Electromagnetic Compatibility Directive, 89/336/EEC, as amended 
by 93/68/EEC 

Supplementary Information: 

The product complies with the requirements of the following Harmonized Product Standards and 
carries the CE-Marking accordingly: 

EN 61010-1: 2001 Safety Requirements for Electrical Equipment for Measurement, 
Control and Laboratory use 

EN 61326-1: 2002 Class A, Electrical Equipment for Measurement, control and 
Laboratory use – EMC requirements 

Signature:
Title:
Date:
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Chapter 1 Introduction

The QualitySpec® Spectrometer is a general-purpose instrument that uses the 
visible near-infrared (VNIR: 350-1000 nm) and near infrared (NIR: 
1000-2500 nm) spectra for material analysis and identification. It has a rapid 
data collection (10 spectra per second). 

The QualitySpec spectrometer is specifically designed for laboratory analysis 
using visible and near infrared spectroscopy. It uses measurements of  
reflectance, transmission, or absorbance to analyze materials.

The ASD Accessories Guide contains an array of devices for the QualitySpec 
spectrometer, that extends the application areas.

Features and Advantages

Accurate and Precise - High signal-to-noise ratio and superior 
repeatability of results for better discrimination and analysis of materials.

Rugged - Resistant to vibration and changes in temperature or humidity.

Fast - 10 spectra per second data collection for the entire 350-2500 nm range. 

» 0.1 second scanning time provides an accurate average every second

» Users can quickly scan several areas when analyzing bulk samples.

» Rapid analysis allows the screening of all or most samples versus spot 
checking.

Compatible - Works with off the shelf chemometrics software, such as 
Grams™ PLS plus/IQ and Unscrambler®.

Symbols - Definitions

CAUTION:  Risk of danger.  This is a personal danager warning.  
Documentation must be consulted in all cases where this symbol is marked.  
Failure to acknowledge these warnings could result in personal injury to the 
user.

CAUTION:  Risk of Electric Shock.  This is a personal warning.  
Documentation must be consulted in all cases where this symbol is marked.  
Failure to acknowledge these warnings could result in personal injury to the 
user.
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CAUTION:  Hot Surface.  This is a personal warning.  Documentation must 
be consulted in all cases where this symbol is marked.  Failure to 
acknowledge these warnings could result in personal injury to the user.

Recycle:  Items with this symbol indicate that the item should be recycled and 
not disposed of as general waste.

Warnings and cautions are placed throughout this manual for convenience of 
the reader.  However, the absence of warnings and cautions do not preclude 
the use of proper caution and handling.  Usual precautions are recommended 
to be taken at all times, either written or otherwise, to avoid personal injury or 
damage to ASD equipment.

1.1 Hardware Specifications

This section contains details about the QualitySpec spectrometer.

1.1.1 Physical Specifications

 

• All vital components are in a dust-proof enclosure and EMI sealed

1.1.2 Power Supply Input and Output Specifications

 

Height  
(including stand)

32.5 cm 12.7 inches

Width 10.8 cm 4.2 inches

Depth 29.5 cm 11.5 inches

Weight 
(not including power 
supply)

6.8 kg 15 lbs 

AC Power Supply Type Auto ranging, Switching, SELV

AC Input 90-240 VAC, 50/60 Hz 

DC Input +12 VDC, 45 Watts
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1.1.3 QualitySpec Wavelength Configuration

The near infrared (NIR) is also called the short-wave infrared (SWIR).

The spectral resolution is:

• 3 nm (Full-Width-Half-Maximum) at 700 nm.

• 10 nm (Full-Width-Half-Maximum) at 1400 nm.

• 10 nm (Full-Width-Half-Maximum) at 2100 nm. 

The sampling interval is:

• 1.4 nm for the spectral region 350-1000 nm. 

• 2 nm for the spectral region 1000-2500 nm. 

The QualitySpec spectrometer may be configured to have three separate 
holographic diffraction gratings with three separate detectors. Each detector is 
also covered with the appropriate order separation filters to eliminate second 
and higher order light.

• VNIR: 512 element silicon photo-diode array for the spectral region 
350-1000 nm.

Instrument Configuration Power Rating (Maximum)

350-1050 nm 12 VDC, 12 Watts

350-1800 nm 12 VDC, 20 Watts

1000-1800 nm 12 VDC, 20 Watts

1800-2500nm 12 VDC, 20 Watts

1000-2500 nm 12 VDC, 25 Watts

350-2500nm 12 VDC, 25 Watts

Wavelength Name Wavelength Range

VNIR-SWIR1-SWIR2 350-2500 nm

VNIR-SWIR1-SWIR2 
(high resolution)

350-2500 nm

VNIR-only 350-1050 nm

VNIR-SWIR1 350-1800 nm
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• NIR1: graded index, TE-cooled, extended range, InGaAs, photo-diode for 
the spectral region 1000 nm to 1800 nm. 

• NIR2: graded index, TE-cooled, extended range, InGaAs, photo-diode for 
the spectral region 1800 nm to 2500 nm. 

1.1.4 Interface Requirement

The QualitySpec spectrometer has 10/100 Base T Ethernet port. The 
spectrometer with an Ethernet cross-over cable can be directly connected to 
the Ethernet port provided on many laptop computers.

 

Note: For information about configuration of the Ethernet card and cable, please 
refer to the Installation Manual.

1.1.5 Standard Accessories

• QualitySpec® Spectrometer 

• QualitySpec® User Manual (PDF on Flash Drive)

• IndicoPro Software Pack

• Power Supply 12 V

• RJ45 CAT 5e UTP Ethernet, Shielded, Crossover Cable

• 64 MB (min.) Flash Drive Memory USB Flash Drive

• Mylar Wavelength Reference
 

1.2 Computer Requirements

Note: The instrument controller is not included with the QualitySpec spectrometer.

The instrument controller is a computer that manages the QualitySpec 
spectrometer, stores data, and processes the results.

The minimum requirements for the instrument controller are: 

• 1.2 GHz Pentium or better notebook or PC-w/monitor 

• 256 MB RAM or more 

• 20 GB of free disk space 

• 1024 x 768 or better graphics resolution 

• 24-bit color or better - 32-bit recommended 

• Ethernet port: 10/100 Base T Ethernet interface
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1.3 Software Requirement

The instrument controller requires the following software:

• IndicoPro Software from ASD.

• Microsoft Windows® 95/98/NT/2000/ME/XP Operating System. 

• Microsoft Internet Explorer 6.0 or better. 

Users need a basic understanding of the Microsoft Windows operating system 
including software installation. 

International customers using non-English versions of Windows must alter 
the Regional Settings under Start->Settings->Control Panel. The 
default language must be set to English (United States) in order for the 
software to be registered and operate correctly. The numbering format must 
also be set to English. 

 

1.4 Theory of Operation

The QualitySpec spectrometer measures the optical energy that is reflected 
by, absorbed into, or transmitted through a sample. Optical energy refers to a 
wavelength range that is greater than just the visible wavelengths, and is 
sometimes called electromagnetic radiation or optical radiation. 

With accessories, various set-ups, and built-in processing of the optical 
energy signal, the QualitySpec spectrometer can measure:

• spectral reflectance, 

• spectral transmittance, and

• spectral absorbance.

Fiber Optic Collection of Reflected/Transmitted Light

Optical energy is collected through a bundle of specially formulated optical 
fibers, precisely cut, polished, and sealed for extremely efficient energy 
collection. The fibers themselves are of low OH composition providing the 
maximum transmission available across the instrument's wavelength range. 

Inside the QualitySpec® Spectrometer

The fiber cable delivers the collected optical energy into the instrument, 
where it is projected onto a holographic diffraction grating. The grating 
separates and reflects the wavelength components for independent 
measurement by the detectors. 
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Visible/Near-Infrared (VNIR)

The Visible/Near-Infrared (VNIR: 350-1000 nm wavelength) portion of the 
spectrum is measured by a 512-channel silicon photodiode array overlaid with 
an order separation filter. Each channel (or detector) is geometrically 
positioned to receive light within a narrow (1.4 nm) range. The VNIR 
spectrometer has a spectral resolution (full-width half maximum of a single 
emission line) of approximately 3 nm at around 700 nm.

Each detector converts incident photons into electrons. This photocurrent is 
continually converted to a voltage and is then periodically digitized by a 
16-bit analog-to-digital (A/D) converter. This digitized spectral data is then 
transmitted to the instrument controller for further processing and analysis by 
the controlling software.

The 512-channel array permits the entire VNIR spectrum to be scanned in 
parallel at 1.4 nm wavelength intervals. A single sample can be acquired in as 
little as 17 ms.

Near Infrared (NIR) or Short-Wave Infrared (SWIR)

The Near-Infrared (NIR), also called Short-Wave Infrared (SWIR), portion of 
the spectrum is acquired with two scanning spectrometers: 

• SWIR1 for the wavelength range of 1000 nm to 1800 nm.

• SWIR2 for the wavelength range of 1800 nm to 2500 nm.

The SWIR scanning spectrometers only have one detector for SWIR1 and 
another for SWIR2. This is different from the VNIR spectrometer, which has 
an array of 512 detectors. Thus, SWIR spectrometers collect wavelength 
information sequentially rather than in parallel.

Each SWIR spectrometer consists of a concave holographic grating and a 
single thermo-electrically cooled Indium Gallium Arsenide (InGaAs) 
detector. The gratings are mounted about a common shaft which oscillates 
back and forth through a 15 degree swing. As the grating moves, it exposes 
the SWIR1 and SWIR2 detectors to different wavelengths of optical energy. 
Each SWIR spectrometer has ~600 channels, or ~2 nm sampling interval per 
SWIR channel. The spectrometer firmware automatically compensates for the 
overlap in wavelength intervals.

Like the VNIR detectors, the SWIR1 and SWIR2 detectors convert incident 
photons into electrons. This photocurrent is continually converted to a voltage 
and is then periodically digitized by a 16-bit analog-to-digital (A/D) 
converter. This digitized spectral data is then transmitted to the instrument 
controller for further processing and analysis by the controlling software.

The grating is physically oscillating with a period of 200 ms. It performs a 
forward scan and a backward scan, resulting in 100 ms per scan. This is the 
minimum time required for any SWIR samples, or full-range samples.
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Communicating with the Instrument Controller (Computer)

The QualitySpec spectrometer communicates with the instrument controller 
using an Ethernet interface. The amount of data that is sent depends on the 
configuration of the spectrometer.

• A single sample of VNIR is ~1024 bytes.

• A single sample of SWIR1 is ~2400 bytes.

• A single sample of SWIR2 is ~2400 bytes.

A full-range QualitySpec spectrometer can create packet data sizes over 
5 KB. Other single or dual range configurations of the spectrometer create 
smaller data packets (adding the packet sizes as above.) 

When features for spectrum averaging (or sample count) are turned on within 
the application software on the instrument controller, the averaging is 
performed at the spectrometer.

Dark Current Measurement

Dark Current (DC) refers to current generated within a detector in the 
absence of any external photons. DC is the amount of electrical current that is 
inherent in the spectrometer detectors and other electrical components and is 
additive to the signal generated by the measured external optical radiation.

Note: Noise is the uncertainty in a given measurement, one channel at a time. Noise 
by definition is random. Noise can be reduced by using more samples and 
averaging the signal. Dark Current is different from noise, because it is 
relatively stable and can be characterized.

This manual uses DC to refer to all systematic contributions to the detector 
signal. DC is a property of the detector and the associated electronics (not the 
light source). DC varies with temperature. In the VNIR region, DC also varies 
with integration time. 

Whenever DC is taken, a mechanical shutter is used to block off the entrance 
slit of the VNIR spectrometer so the signal can be measured. This signal is 
subtracted from each subsequent spectrum until another DC is taken. The 
SWIR spectrometers take and subtract DC on every scan.

The DC measurement can be updated at any time, but should be updated more 
frequently in the beginning of a given session while the instrument warms up.

The VNIR spectrometer is fitted with a unique software and hardware 
combination feature called Driftlock. Driftlock corrects for DC changes over 
time. It automatically updates DC for every measurement by looking at a 
series of masked pixels at the front portion of the VNIR array. The Driftlock 
feature corrects for the majority of DC variation over time.

Baseline (or White Reference)

A material with approximately 100% reflectance across the entire spectrum is 
called a white reference panel or white reference standard. 
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The raw measurement made by the spectrometer is influenced by both the 
sample and the light source. An independent measure of the light source 
illumination on a reference of known reflectance is required to calculate the 
reflectance of the sample. The use of a white reference standard with near 
100% reflectance simplifies this calculation.

Reflectance and transmittance are inherent properties of all materials and are 
independent of the light source. 

Reflectance is the ratio of energy reflected from a sample to the energy 
incident on the sample. Spectral Reflectance is the reflectance as a 
function of wavelength.

Transmittance is the ratio of the radiant energy transmitted through a sample 
to the radiant energy incident on the surface of the sample. Spectral 
Transmittance is the transmittance as a function of wavelength.

Relative reflectance is computed by dividing the energy reflected from the 
sample by the energy reflected off a white reference panel or standard. 

Accessories for Light Sources and Probes

ASD offers several accessories for:

• Delivering illumination to the sample.

• Collecting reflected or transmitted light from the sample.

• Transmitting the collected light to the spectrometer. 

Some accessories, such as the Contact Probe, perform all of these functions. 
Other accessories, such as some of the optional foreoptic probes, rely on other 
illumination sources.

Accurate analysis of collected spectra requires an adequate level of incident 
light on the sample. The ASD accessories are designed for stability and 
accuracy and provide a controlled source of incident light. Characteristics of 
the light source are eliminated when the baseline spectrum is applied to each 
raw sample spectrum.
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Inspect the shipping container and take careful notes regarding any damage 
that might have occurred during shipping. 

Note: Save all packing materials, foam spacers, and paperwork for possible future 
use.

Prepare a clear space on a sturdy bench or counter, ideally, a space near a 
wall-current receptacle and the controlling computer. 

Carefully open the shipping container following all instructions and 
orientation labels on the container.

2.1 Unpacking the Instrument 

Figure 2-1 QualitySpec spectrometer front-view showing fiber connection to a contact 
probe (sold separately).
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Step 1 Carefully remove the instrument from the shipping case.

Figure 2-2 QualitySpec spectrometer front-view showing fiber connection to USP filter 
wheel and light box.

 

WARNING! The fiber cable should never be stored with a bend of less 
than a 5" diameter for long periods of time, because the 
cable can be damaged with undetectable longitudinal 
fractures that can cause light leakage and weaker signals.

2.2 Power Supply

The QualitySpec spectrometer requires input power to be 12 VDC (50 W). It 
does not contain an internal power supply to convert AC voltage to DC, nor 
does it have internal batteries.

An external power supply that converts 100 VAC to 240 VAC (50 Hz or 
60 Hz) to 12 VDC (shown in Figure 2-3).

• An external adapter for vehicle cigarette lighters (sold separately and 
should not be used with vehicle engine running).
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Use only ASD approved power supplies or connectors to 
power the instrument.

Figure 2-3 QualitySpec spectrometer power supply and cables.
 

Figure 2-4 QualitySpec spectrometer power connector which plugs into the instrument.
 

Insert power (battery or power supply) into the receptacle on the back panel 
labeled “INPUT 12 VDC 50 WATT”. Lock the connector in place by 
twisting the barrel end of the connector clockwise.
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Figure 2-5 QualitySpec spectrometer back panel showing Ethernet connection, power 
switch, and power input jack.

  

2.3 Ethernet Cables

For Information about configuration of the Ethernet card and cable please 
refer to the Installation Guide. Only use shielded Ethernet cables to reduce 
electromagnetic interference with the instrument.

Note the location of the computer interface connection. Figure 2-5 shows the 
back panel containing the Ethernet port, which is labeled 
“RJ45/ETHERNET”.

With the QualitySpec spectrometer and the instrument controller fully 
powered-down and turned-off, plug the shielded cross-over Ethernet 
computer cable (as shown in Figure 2-6) into the Ethernet ports of the 
QualitySpec spectrometer and your instrument controller.
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Figure 2-6 Shielded cross-over Ethernet cable.
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Chapter 3 Usage and Maintenance

For your safety and to prevent damage to the instrument, please review the 
following safety precautions. All operators should be familiar with this 
information.

3.1 Light Sources

Use only light sources supplied by ASD Inc. Light sources supplied by ASD 
are designed to provide levels of illumination and stability of output that 
complement the performance of ASD's instrumentation.

• Never touch the light source bulb and avoid contact with hot metal 
components near the bulb! Heat transfer from the light source may make 
these metal components uncomfortably warm to the touch. 

• Prevent dirt and oils from contacting the bulb and reflector. 

• Do not touch the glass envelope of the bulb. Oils on the hand may transfer 
to the glass envelope, which can significantly affect the bulb temperature 
and corrupt important operating physics of the bulb. 

Note: Please refer to the ASD Accessories Manual or the instructions for 
that specific accessory for detailed information.

3.2 Access and Ventilation

When used inside, provide adequate room ventilation for the spectrometer. 
Insufficient ventilation can result in overheating of the spectrometer and 
subsequently corrupted data and possibly physical damage to the 
spectrometer. 

Do not cover the vents of the instrument. 

Do not place objects on the unit or the power supplies. Prevent objects from 
obstructing ventilation slits.

Keep objects and spills from entering or falling onto the instrument, power 
supplies, and software disks. 
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3.3 Cleaning

Step 1 Turn off the unit.

Step 2 Disconnect from all power.

Step 3 Allow the unit to cool down.

Step 4 Clean unit with a slightly damp cloth and mild soap. 

Note: Be sure all soap residue is removed and all surfaces are dry before 
use.

 

3.4 Annual Maintenance

ASD recommends that the instrument be serviced once a year. This will 
ensure the proper function of the instrument. Annual maintenance is covered 
under ASD warranty or the extended service contract. Annual maintenance 
can be purchased separately. If you are interested in purchasing annual 
maintenance or an extended service contract, please contact your sales 
representative. 

3.5 Returning Instrument to ASD for Service

In order to return the instrument to ASD for maintenance or repair, a Return 
Merchandise Authorization (RMA) must be issued by ASD technical support. 
The RMA includes scheduling details, contact information, shipping 
instructions, as well as a brief description of the maintenance or repair 
requirements. Please contact the technical support department at 
303-444-6522 X-144 or support@asdi.com. 
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Chapter 4 Fiber Optic Interface

ASD offers a variety of fiber optic cable lengths to interface with the 
QualitySpec spectrometer. These fiber optic cables are used for reflectance 
and transmittance measurements.

Fiber optic cables should be loosely coiled and stored in the compartments 
provided. All accessories should be stored in the designated compartments of 
the carrier or in a separate protective case. 

 

4.1 Fiber Optics Cables

The spectrometer includes an internal fiber optic cable (built into the 
instrument.) The Accessories Guide offers many options for the external cable 
(ordered separately), which is used for making measurements.

• The built-in fiber optic cable is made up of fifty-seven (57) randomly 
distributed, ultra low-OH, silica glass fibers. Nineteen (19) of these fibers 
are 100 micron and are distributed to the VNIR region. The remaining 
thirty-eight (38) fibers are 200 micron and are evenly divided between the 
two SWIR regions.

• The external fiber optic cable is made up of forty-four (44) randomly 
distributed, ultra low-OH, silica glass fibers that are 200 micron. This 
cable has a Numerical Aperture (NA) of 0.22.

The external fiber optic cable length is typically 1 meter. Additional external 
fiber optic cables can be ordered in a variety of lengths. However, as the 
length increases, the cable’s transmission decreases at wavelengths below 
400 nm and above 2000 nm.

The external fiber optic cable protects the fibers with a metal spiral inside the 
black PVC cable casing. If there are kinks in the cable, the fibers are not 
necessarily damaged. If, however, the cable has been damaged so severely 
that the protective metal spiral can be seen, the fibers may have been 
damaged. Each broken fiber results in a ~5% loss of response. 

WARNING! The fiber optic cable should never be stored with a bend of less than a 5" 
diameter for long periods of time.
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The fibers can be damaged by coiling the cable up too tightly. If left in a tight 
coil for longer than a week, the fibers are likely to develop longitudinal 
fractures that will not be detectable. These fractures in the fiber will cause 
light leakage, resulting in a weaker signal. The fiber optic cables should be 
stored loosely.

Tips on care for the fiber optic cable:

• Do not pull or hang the spectrometer by the fiber optic cable. 

• Do not use wires, ties, or clamps to tightly attach the fiber optic cable to 
objects, these might pinch or penetrate the protective jacket thereby 
damaging the fibers inside. 

• Avoid whipping the fiber optic cable, dropping it, or slamming it into 
objects, this can cause fractures to the glass fibers. 

• Avoid twisting the fiber optic cable, such forces may cause fractures to 
fibers.

While the tip of the fiber optic cable is not particularly susceptible to damage, 
a tip cover is recommended to protect against abrasion and exposure to 
contamination. Replacement covers can be made by cutting pieces of 
eighth-inch shrink tubing to about 1.5" lengths and shrinking them onto the 
fiber cable tip. The covers will slide on and off the cable easily. 

 

4.2 Fiber Optic Cable Interface

All fiber optic cables come with a standard SMA style 905 connector, as 
shown in Figure 4-1

Figure 4-1 Connector for the fiber optic cable.
 

In order to achieve the best response from ASD instruments it may be 
necessary to adjust the fiber optic interface between the external fiber optic 
cable (shown in Figure 4-2 and Figure 4-3) and the instrument connection.
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Figure 4-2 View of the fiber optic bundle matcher and the fiber optic port.
 

Note: The fiber optic bundle matcher has a standard 1.7 mm fiber optic bundle 
input.

Figure 4-3 View of the fiber optic cable, fiber bundle matcher, and fiber connection. The 
fiber bundle matcher should be screwed into the fiber connection as far as 
possible. 
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Figure 4-4 QualitySpec spectrometer front-view showing fiber connection to USP filter 
wheel and light box.

 

ASD external fiber optic cables most commonly come in one of the 
configurations listed in Figure 4-5. The millimeter size (mm) is the internal 
diameter of the fiber optic bundle.

Figure 4-5 Examples of the external fiber optic cable diameters.
 

4.3 Matching Fiber Bundles

Now that there is an understanding of how the external fiber optic cables and 
the fixed fiber optic bundle matcher are configured, they need to be 
combined. The three scenarios in Figure 4-6 show how the fiber optic bundles 
are matched. 
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Figure 4-6 Matching fiber bundles to the QualitySpec spectrometer’s fiber port.
 

Note: The optimal setting for this fiber optic bundle matcher is adjusted at the ASD 
factory. If the customer has ordered several fiber optic configurations, it may 
be necessary to adjust this bundle matcher in order to achieve the highest 
signal to noise ratio and best instrument response. Changing the bundle 
matcher can effect the performance of the spectrometer.

In order to match the bundles:

1 Unlock the hex-nut bolt at the front of the bundle matcher on the 
spectrometer with the 3/8 in hex-nut driver (included with the 
instrument.) 

2 The QualitySpec spectrometer should be set up with the adjustment barrel 
of the matcher fully threaded into the body of the matcher any time a full 
1.7 mm bundle is used (which is almost always).

3 With the ASD software application (RS3 or Indico) running and the fiber 
optic cables attached, hand screw the fiber optic bundle matcher until the 
optimal signal is achieved. Do not over twist the fiber optic bundle! 

The optimal signal will be achieved by watching the RAW DN 
(DN = digital numbers) in the ASD application as the fiber optic bundle 
matcher is being hand adjusted. 

Note: The QualitySpec spectrometer should be set up with the  
adjustment barrel of the matcher fully threaded into the body of 
the matcher any time a full 1.7 mm bundle is used.

4 Once the optimal signal is achieved, lock down the fiber optic bundle 
matcher. Tighten the 3/8 hex-nut by turning the wing nut against the face 
of the instrument. Use the hex wrench to hold the 3/8 hex-nut in place 
while you tighten the wing nut.

When the bundle matcher is removed, clean the fiber optic cable and the 
exposed fiber optic on the spectrometer. This can be done by using de-ionized 
water, cleaning the end, and then gently wiping the excess off. Canned air to 
blow off any dust that may have accumulated can also be used.
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4.4 LED Check for Fiber Optic Cable

The QualitySpec spectrometer allows you to perform a visual verification of 
the internal fiber optic cable using built-in LEDs, a magnifier placed on the 
fiber optic bundle matcher, and the Fiber Check software.

WARNING! The Fiber Check utility produces rapid flashing lights in the SWIR 1 
and 2 region's optical fibers. If you are susceptible to epileptic seizures, 
exercise caution or avoid using the Fiber Check utility.

Step 1 Remove any external fiber optic cable from the spectrometer.

Step 2 Remove the bundle matcher. Use the 3/8 inch hex-nut driver to loosen the 
bundle matcher if necessary.

Step 3 Remove the Fiber Optic Port using the 9/16 nut driver (included with the 
instrument.)

Figure 4-7 Fiber Optic Port

Step 4 Carefully insert the tip of the magnifier until it butts up against the internal 
fiber optic, as shown in Figure 4-8. 

Note: Be careful not to apply any load or torque to the magnifier which could 
break the tip off.
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Figure 4-8 Magnifier for testing the internal fiber optic cable.
 

Step 5 On the instrument controller, exit any ASD applications that might be running 
and communicating with the unit. Such applications include RS3 and Indico.

Step 6 Ensure that the spectrometer is turned on.

Step 7 Start the Fiber Check application from the Start menu under 
All Programs->ASD Programs->Indico Pro Tools->Fiber Check.

Figure 4-9 Fiber Check Program
 

Step 8 Ensure that the IP address configured is the one for the spectrometer.

Step 9 Use the mouse to select the checkbox for the LED to turn on: VNIR, SWIR1, 
or SWIR2. One or more may be selected at once.

Note: If a range is selected that the spectrometer does not have, that 
particular LED will not be available to turn on. Nothing will be 
harmed. 
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Step 10 Select the Check button which turns on the selected LEDs.

Step 11 Look through the magnifier to see which fibers light up. 

• Count the number of fibers that show light. Refer to Details about the 
Fiber Optic Cable and LEDs.

• If applicable, use the checkboxes and the Check button shown in 
Figure 4-9 to turn on and off different LEDs to help determine which 
range might be affected.

Note: The RED LED for VNIR may be hard to see when the other 
ranges are enabled.

Figure 4-10 Internal spectrometer LED shining to test internal fiber optic cable.
 

Step 12 When you are finished, shutdown the Fiber Check application.

Step 13 Carefully remove the magnifier and re-attach the bundle matcher and fiber 
optic port using the 9/16 nut driver.

Step 14 Inspect the external fiber optic cable disconnected from the instrument.

1 Unscrew the lens from the magnifier and place it onto the short magnifier 
assembly

Figure 4-11 Short and Long Magnifier Assemblies
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2 Attach the magnifier to one end of the fiber optic cable.

3 Point the other end of the fiber optic cable close to a light.

4 Observe which fibers transmit light.

Details about the Fiber Optic Cable and LEDs

• The LEDs will only turn on for the ranges installed in the spectrometer. 
Selecting one that the spectrometer does not have will not cause a 
problem.

• Each range has a different LED color so that you can see the fibers in the 
cable that are associated with it: RED for VNIR; WHITE for SWIR1; 
GREEN for SWIR2.

• The fiber bundle of the internal cable for each range contains 19 fibers. 

• The fiber bundle of the external cable contains 44 fibers. 

• Each broken internal fiber results in an approximate 5% loss of response 
in that particular range (VNIR, SWIR1, or SWIR2). Each broken external 
fiber results in a few percentage loss of response over the entire range. It 
is hard to quantify how a broken fiber in the external cable affects the 
response of any given range, each time the external cable is connected to 
the spectrometer, the alignment with the fibers of the internal cable will 
most likely be different.

The instrument can be successfully used with a few broken fibers in each 
range, although with a reduction in signal strength. 

For severely damaged internal fiber optic cables, send the instrument back to 
ASD Inc. in its carrying case for repairs. For severely damaged external fiber 
optic cables, order replacements from ASD Inc.
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Chapter 5 Measurements

Accurate and repeatable material analysis or identification requires the 
accurate and repeatable measurement of reflectance, transmission, or 
absorption. It requires an awareness of the influences of:

• Sources of illumination.

• Instrument field-of-view.

• Sample viewing and illumination geometry.

• Instrument scanning time.

• Spatial and temporal variability of the sample characteristics. 

Many of these parameters are controlled when using one of ASD’s standard 
sampling interfaces (e.g., MugLite or Contact Probe).

5.1 Illumination

In order to determine the reflectance or transmittance of a material, two 
measurements are required: 

• The spectral response of a reference sample.

• The spectral response of the target material. 

The reflectance or transmittance spectrum is then computed by dividing the 
spectral response of the target material by that of a reference sample. 

5.2 Suggested Set-up

Step 1 Follow the instructions for plugging in the instrument and starting the Indico 
software.

Step 2 Attach an appropriate accessory. Remember that the QualitySpec 
spectrometer requires an external (artificial) light source.

Step 3 Open a new project either by selecting File->New Project from the 
pull-down menu.



ASD Document 600548 Rev. C 28  QualitySpec® User Manual

 www.asdi.com Chapter 5 Measurements

Step 4 Type in a name for this project and press the OK button.

Step 5 Select Spectrum->Sample Count/Average from the pull-down menu.

Step 6 Set the Instrument Sample Count to 30 for indoor or artificial 
illumination.

Note: The actual spectrum average will be determined by striking a 
compromise between noise reduction through averaging the spectra 
and the time desired for each spectrum collection. For instance, if the 
instrument is being used in the field, a large area is being walked, and  
frequent spectral readings are being taken, a shorter average setting is 
required than if collecting spectra in-situ and the cleanest spectra 
possible is desired.

The project screen will return, and the sample count will be displayed in the 
status box at the bottom of the graph.

Step 7 Ensure the light source is on and the probe input end is pointed at the white 
reference panel. 

Step 8 Select Spectrum->Take a Baseline [Alt+S, B] [Ctrl+R]. When 
prompted, press Yes, take a new white reference.

• The QualitySpec spectrometer optimizes the detector sensitivities for the 
probe and light source currently being used. 

• The dark offset and white reference will also be measured and saved.

• Status bars will indicate each process. 

When optimization and white reference are complete, a straight baseline 
across the Project Graph should be seen at 1.00 (100%). 

Step 9 Select the Display->Reflectance [Alt+D, R] for the reflectance mode.

Step 10 Place the sample on the white reference panel and the spacer end in contact 
against the sample.

This assumes that the reflectance probe has appropriate spacing or spacers on 
the end.

Step 11 Press the Space Bar once or select the Spectrum->Take a Scan [Alt+S, 
T]. 

When the QualitySpec spectrometer finishes recording and averaging the 
Spectra, the graph in the project window will be updated to show the 
reflectance spectrum of the sample.

Step 12 Observe samples.
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5.3 Baseline Collection (or White Reference)

A material with 95-99% reflectance across the entire spectrum is called a 
white reference panel or white reference standard. 

The raw measurement made by the spectrometer is influenced by both the 
sample and the light source. An independent measure of the light source 
illumination on a reference of known reflectance is required to calculate the 
reflectance of the sample. The use of a white reference standard with near 
100% reflectance simplifies this calculation.

The ASD application software, such as RS3 and Indico, can calculate the 
ratios for reflectance or transmittance of the material being sampled by the 
QualitySpec spectrometer using the white reference as the standard.

Spectralon from Labsphere is the white reference standard that is very 
suitable for the VNIR and SWIR spectral ranges of ASD instruments.

Spectralon is made of polytetraflouroethylene (PTFE) and cintered halon. It 
has the characteristic of being nearly 100% reflective within the wavelength 
range of 350 nm to 2500 nm. A Spectralon white reference scatters light 
uniformly in all directions within that wavelength range.

5.3.1 Maintaining Spectralon References

Spectralon is an optical standard and should be handled in much the same way 
as other optical standards. Although the material is very durable, care should 
be taken to prevent contaminants such as finger oils from contacting the 
material’s surface. Always wear clean gloves when handling Spectralon.

To clean a lightly soiled Spectralon white reference

If the material is lightly soiled, it may be air brushed with a jet of clean dry air 
or nitrogen. 

WARNING! DO NOT use Freon. 

To clean a heavily soiled Spectralon white reference

Sand the Spectralon material under running water with a 220-240 grit 
waterproof emery cloth or sandpaper until the surface is totally hydrophobic 
(water beads and runs off immediately). 

Step 1 Use a flat surface, such as a thick, flat piece of glass.

Step 2 Place the glass into the sink.

Step 3 Place 220 grade wet sandpaper onto the glass.

Step 4 Gently move the Spectralon reference in a figure 8 motion on the sandpaper, 
using water as needed to wash away the thin layer that is sanded off. 
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Step 5 Blow dry with clean air or nitrogen or allow the material to air dry. 

Step 6 If the material requires high resistance to deep UV radiation, the piece should 
be prepared as above, then either of the following two treatments performed.

1 Flush the Spectralon piece with >18 milli-ohm distilled, deionized water 
for 24 hours.

2 Vacuum bake the Spectralon piece at 75° C for a 12 hour period at a 
vacuum of 1 Torr or less. Then purge the vacuum oven with clean dry air 
or nitrogen.

WARNING! Do not use oils or soaps to clean the Spectralon white 
reference.

5.3.2 Baseline Reference Procedures

Baseline references, or white references, should be collected approximately 
every 15 minutes while the instrument is warming up; thereafter, every hour 
or so is sufficient. The Spectralon puck should be used when optimizing and 
taking a white reference measurement. 

The QualitySpec spectrometer should be re-optimized for:

• Light changes.

• Temperature changes.

• Whenever accessory probes are changed.
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Appendix A Troubleshooting

A.1 Common Communication Fixes

To fix many communication errors (particularly if the instrument has been 
functioning at some point), power cycle the instrument and/or the instrument 
controller. 

The sequence to use will vary depending on the computer manufacturer. 
Either:

• Leave the computer on. Turn off the instrument. Wait for 10 seconds. 
Turn the instrument back on.

• Or, turn off the computer and the instrument. Turn on the instrument. 
Then turn on the instrument controller. 

A.2 Does Not Connect to the Spectrometer

• Refer to section A.1, Common Communication Fixes.

• Check that the Ethernet cable is securely inserted into the spectrometer 
and host computer. Check that the Ethernet LED is on.

• For an isolated network, check that the Ethernet cable is a cross-over 
Ethernet cable.

• For an established network, check that the Ethernet cable is a standard 
Ethernet cable.

• Check that the IP Address is in the same range or subnet as the ASD 
spectrometer. The same subnet means that the first three octets of the IP 
address (xxx.xxx.xxx.___) match the spectrometer and the computer.
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• Do a ping test to make sure the spectrometer is responding. 

» Open up a command window by select Start->Run 

» Type cmd in the Run window.

» Select OK to open the window. 

» For an Ethernet connection, type: ping 10.1.1.11  

» For a wireless connection, type: ping 10.1.1.77 

Figure A-1 Run window with cmd.
 

Figure A-2 Successful result of a ping operation.
 

The default IP Address for the ASD spectrometer is:

• 10.1.1.11 for the Ethernet interface, or

• 10.1.1.77 for the wireless interface. 

The default subnet mask is 255.255.255.0. 
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The computer's Ethernet adapter or wireless adapter must have a unique IP 
address in the same range as the spectrometer, such as 10.1.1.x where x is a 
unique number. The subnet mask must also be the same as the spectrometer. 
such as 255.255.255.0.
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Notes: 
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Appendix B Reference Information

B.1 Frequently Asked Questions (FAQ)

B.1.1 What is a spectrometer?

Spectrograph - An optical instrument for forming the spectrum of a light 
source and recording it on a film. The dispersing medium may be a prism or a 
diffraction grating. This term was common prior to the digital age. ASD 
instruments do not use film.

Spectrometer - An optical instrument which uses detectors other than 
photographic film to measure the distribution of radiation in a particular 
wavelength region. All ASD instruments are spectrometers.

Spectroradiometer - An optical instrument for measuring the radiant energy 
(radiance or irradiance) from a source at each wavelength throughout the 
spectrum. A spectroradiometer is a special kind of spectrometer. 

Note: Only the FieldSpec spectrometer is configured as a 
spectroradiometer. The reason is that the fiber optic cable 
significantly affects the calibration required to measure radiance. The 
FieldSpec instrument has a fixed fiber optic cable routed directly 
through the front panel to the internal spectrometers, while the other 
ASD spectrometers are designed to detach and even interchange fiber 
optic cables. To be meaningful, radiance measurements with 
non-FieldSpec instruments would have to be performed using the 
same fiber optic cable and the same connector orientation 
of the plugged in fiber optic cable as the factory calibration.

The SWIR component of the ASD spectrometer is a scanning spectrometer, 
while the VNIR component is an array spectrometer.
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B.1.2 What are the differences between the ASD 
spectrometers?

FieldSpec - is a general-purpose spectrometer specifically designed for field 
environmental remote sensing. The FieldSpec is a spectroradiometer in 
that it is calibrated to be able to perform radiance and irradiance 
measurements, as well as reflectance and transmittance. The fiber optic 
cable is routed through the front panel and is fixed to the internal 
spectrometers, which provides a superior signal-to-noise ratio than the 
other ASD spectrometers with detachable fiber optic cables. (The 
FieldSpec spectrometer can also be specially ordered as a high-resolution 
instrument, the main TerraSpec feature.)

TerraSpec - is a high-resolution spectrometer specially designed for mining 
and geology applications. It is ideally suited for performing reflectance 
spectral measurements of rocks, minerals, and core samples. Its higher 
resolution is optimized for samples that have high absorption features. 
The Hi-Brite MugLite and Hi-Brite Contact Probe are designed to work 
with this spectrometer.

AgriSpec - is a general-purpose spectrometer designed for agriculture and the 
field analysis of vegetation and soils. Its resolution is ideally suited for 
performing reflectance and transmittance spectral measurements of 
samples that have broad absorptions features. This spectrometer can use 
nearly all of the accessories containing a light source, such as the plant 
probe and leaf clip.

LabSpec - is a general-purpose spectrometer designed not only for laboratory 
analysis, but also for the plant floor, receiving, and even field work. It is 
meant to be portable for multiple uses requiring visible and near infrared 
reflectance, transmission, or absorbance to analyze and identify materials. 
The LabSpec is similar to the AgriSpec. The LabSpec 2500 has a 10 nm 
resolution, while the LabSpec 2600 has a 6 nm resolution.

QualitySpec - is a general-purpose spectrometer specifically designed for 
material analysis and identification in the laboratory. The QualitySpec 
features are equivalent to the AgriSpec except that it is not field-portable. 

B.1.3 How often do I need a (baseline) White Reference?

When using the instrument inside under constant lighting conditions or when 
using an accessory with its own light source, collect a (baseline) white 
reference every 10 to 15 minutes while the instrument is warming up and then 
every hour or so thereafter.
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B.1.4 What spectrum average (or sample count) should I use?

When used with a MugLite, Contact Probe, or other accessory, it is usually 
sufficient to use 10-20 scans in the spectrum averaging (or sample count) for 
the sample and 20-40 scans for the white reference. The white reference isn’t 
taken as often, which is why you would want to include more scans in its 
averaging. 

The signal-to-noise measurement increases with the square root of the number 
of scans used in the averaging.

Note: The actual spectrum average will be a compromise between noise reduction 
through spectra averaging and the time required for each spectra collection. 
For instance, if you are using the instrument in the field to measure a large 
number of samples, you will want a smaller number of spectra in the average 
to decrease the collection time required. If you are collecting spectra in the 
lab, you’ll want to increase the number of spectra in the averaging to obtain 
the cleanest spectra possible.

B.1.5 Can I post-process my data?

Yes. ViewSpec is one of many applications that can post-process your data. 
Various software packages are available for chemometric model. The spectral 
data can be imported into many different applications.

The complete specification of the ASD file format is available upon request.

B.1.6 Why do I see oscillations (sine wave) in my data?

Your light source may use AC power. A single SWIR band is about 100 ms. If 
you observe five (5) or six (6) waves in a single SWIR, the AC light source is 
the cause.

Waves can also occur if the lamp reflector and/or cover glass behave as a 
white-light interferometer. Solution: remove the glass and/or use a more 
diffuse reflector.

B.1.7 What are these upward or downward spikes in VNIR 
data?

These result from artificial light sources, in particular fluorescent lights.
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Figure B-1 Spectrum of fluorescent lights

B.1.8 What are these steps in my data?

Light is brought into the instrument by various combinations of the strands in 
the fiber optic cable. Each strand has its own field-of-view (FOV). When the 
cable is held close to the sample, each strand views slightly different portions 
of the sample. This can result in the stepped data. 

Stepping of data is common when the foreoptic has a lens, and less common 
when using the bare optics or sampling devices.

B.1.9 What can cause more noise in my data from last time?

Many factors can cause noise in your data from one session to another. Noise 
in a measurement is related to the instrument, the signal level, and noise in the 
light source. Many times the appearance of noise is actually a decrease in the 
strength of the signal, as opposed to an increase in noise. 

Under normal operating conditions, noise visible in a spectrum is always the 
result of a trade-off between the inherent noise in the system and the signal. 

Check how the external fiber optic cable is aligned with the internal cable for 
changes in signal through-put.

Also, broken fibers in the fiber optic cable can contribute to noise. Perform a 
fiber optic check to verify.
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An increase in noise can be due to a problem in the instrument such as an 
electronic component malfunction or a grounding problem. This will many 
times be indicated by a regular pattern to the noise or periodic bursts of noise 
that are visible over the normal spectra. 

B.1.10 What does a broken fiber mean?

The internal fiber-optic cable is made up of fifty-seven (57) randomly 
distributed glass fibers. 

• 19 fibers are 100 micron for the VNIR region.

• 19 fibers are 200 micron for the SWIR1 region.

• 19 fibers are 200 micron for the SWIR2 region.

Therefore, a single broken fiber in the internal cable results in a ~5% 
reduction in the signal in a given region.

The external fiber-optic cable is made up of forty (44) 200 micron glass 
fibers. 

Note: Each broken external fiber results in a few percentage loss of response over 
the entire range. It is hard to quantify how this affects the response of any 
given range, because each time the external cable is connected to the 
spectrometer, its alignment with the fibers of the internal cable will most 
likely be different.

A few broken fibers is not critical when measuring reflectance, because this is 
a ratio. Any noise introduced by the broken fibers in measuring the sample 
were also present when measuring the white reference, and therefore cancels 
out.

The fibers are protected by a metal spiral inside the black cable casing. If 
there are kinks in your cable, the fibers are not necessarily damaged. 
However, if your cable has been crunched so severely that you are able to see 
the protective metal spiral, the chances are high that the fibers have been 
damaged too. Refer to the Fiber Optic Check utility to determine if any fibers 
are broken.

The fibers can be damaged by coiling the cable up too tightly. If left in a tight 
coil for longer than a week, the fibers are likely to develop longitudinal 
fractures that will not be detectable. These fractures in the fiber will cause 
light leakage, resulting in a weaker signal. The fiber optic cables should be 
stored by placing them loosely within the netting compartment on the 
instrument.

WARNING! The fiber cable should never be stored with a bend of less 
than a 5" diameter for long periods of time.
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B.1.11 What type of Ethernet cable can I use for the static IP 
configuration?

The spectrometer can be plugged directly into the instrument controller using 
a cross-over, shielded Ethernet cable.

When the spectrometer and instrument controller communicate over a 
network, use standard shielded Ethernet cables and IP addresses compatible 
with the network. The spectrometer imposes significant traffic on the 
network, which can cause packet delays to other users. More importantly, 
network traffic from other users can negatively impact the reliability of the 
communication between spectrometer and instrument controller.

B.1.12 Can I install additional software on the instrument 
controller?

Yes, but with qualifications.

The types of applications that can interfere with the measurement of data are 
utility programs, network programs, and those working in the background, 
such as virus checkers.

ASD programs, such as RS3 and Indico, require real-time access to the data 
that is being streamed from the QualitySpec spectrometer at a high rate of 
speed. Programs running in the background can cause packets to be lost.

Microsoft Office, image processing programs, and other software applications 
generally do not interfere with ASD programs, particularly if they are not 
running and competing for CPU cycles and RAM at the same time that data is 
being collected from the QualitySpec spectrometer.

B.1.13 Why does the software seem to do unexpected things?

To assure accuracy in the collection and processing of data, the ASD 
application software is designed to finish its current operation before moving 
on. The QualitySpec spectrometer outputs a lot of data at a high rate of speed 
for the ASD application software to collect. 

In addition, the ASD application software will stack up your keystroke entries 
and execute them later in the order they were received.

It is important that you wait for the collection to finish before entering the 
commands to launch another operation. Don’t rush into new operations or into 
issuing new commands until you see the results of the current command.
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B.1.14 How long does it take for the QualitySpec spectrometer 
to warm up?

The warm-up time of the instrument depends on the environment in which it 
is used. 

Only 15 minutes is needed for reflectance measurements. 

B.1.15 Where is my serial number?

The serial number is a five (5) digit number located on a label on the rear of 
the QualitySpec spectrometer where the power switch is. The label also 
contains the model number and MAC address for the spectrometer.

Figure B-2 Label with serial number.

The serial number is also accessible in the RS3 and Indico applications from 
the splash screen or the Help->About menu item.

 

B.2 Data Conversion

When using the Indico application, converters are available for Grams/AI, 
Unscrambler, and ASCII.

Conversion can be done one file at a time. Or, several files can be merged into 
a single text file, which is a useful feature when inputting data into other 
analysis programs. 

B.3 Optimization

The QualitySpec spectrometer must be re-optimized for:

• Every 30 minutes when used with artificial light sources.
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• Changes in temperature.

Optimization depends on the response to light in a particular spectral region. 
A well-optimized instrument will display between 20,000 and 35,000 raw 
digital numbers, if the source is within the gain and integration time abilities 
of the system. The magnitude of the VNIR raw DN will be directly dependent 
on the light intensity.

The Spectralon blank should be used when optimizing and for taking a white 
reference measurement. 

Note: It is important that the position of the reference sample when taking a white 
reference is as similar as possible to the position for capturing data from the 
samples.

B.4 Spectrum Averaging (or Sample Count)

If signal levels are low, the only way to increase S/N is by reducing noise 
through spectrum averaging. However, spectrum averaging takes more time 
per spectrum. 

B.5 Temperature Effects

The QualitySpec spectrometer instruments have thermo-electrically cooled 
SWIR detectors (to -25 C), significantly reducing noise in those areas. 

When the system fails due to extreme temperature, it will fail gradually but 
the data won't make perfect sense. Shut down and let the instrument cool 
before operating again.

The ASD applications provide a warning when the SWIR detectors are out of 
thermal regulation.

B.6 Technical Support

If you have any questions or concerns, please contact ASD Inc. by phone, fax, 
or email:

Phone: 303-444-6522 X-144 
Fax: 303-444-6825 
email: support@asdi.com 
Web: www.asdi.com 
ftp: ftp.asdi.com
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Technical support is committed to providing you with a timely response to 
your questions. We will work with you to provide solutions to your 
applications. Technical support is available to answer your questions Monday 
thru Friday, 8 am to 5 pm Mountain Standard Time. We will happily respond 
to your e-mail queries as well.

B.7 W.E.E.E. Compliance

Analytical Devices supports the W.E.E.E. Regulation.  ASD marks the 
instrument with the symbol at the left to show that this product has entered the 
market place after August 13, 2005.

If you decide to end the use of the spectrometer, please do not discard it as 
general waste.  ASD will accept the return of the instrument for recycling 
purposes.  Contact ASD Customer Service to arrange for the return of your 
instrument.
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Notes: 
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